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Test	cricket	app
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"Our	plan	is	to	have	a	section	of	the	app	where	people	will	give	you	a	further	level	of	consensus,"	said	Abecasis,	allowing	participants	to	decide	whether	they	want	to	discover	their	genetic	predispositions.	"We	think	the	data	of	his	people	and	who	should	do	with	it	what	they	want,"	said	Abecasis.	The	researchers	are	still	discussing	this	plan	with	an
ethical	review	edge	of	the	project,	not	to	added.There	nothing	revolutionary	on	online	health	information	sharing,	Robert	Green,	a	medical	geneticist	at	Boston's	Brigham	and	Women	Hospital,	said	Buzzfeed	said	News.	"There	are	all	kinds	of	health	applications	under	construction	at	this	time	that	allow	you	to	share	operating	or	fitbit	information	or
anything	else	you	want	to	share	on	the	main	social	networks."	But	when	it	comes	to	risks	of	genetic	diseases,	information	sharing	outside	a	medical	practice	is	extremely	controversial.	Some	ethics	experts,	doctors	and	genetic	consultants	fear	that	tell	people	about	their	potential	genetic	risks	could	lead	to	unjustified	fears	or	misunderstandings.	The
FDA,	meanwhile,	is	becoming	increasingly	aggressive	about	the	regulation	of	the	genetic	test	Industry.consider	23Andme,	a	genetic	testing	company	in	Mountain	View,	California.	The	company	of	$	99	"Explane	kit"	used	to	provide	customers	with	information	on	genetic	descent	and	disease	risk.	At	the	end	of	2013,	however,	the	FDA	decided	that	the
medical	interpretations	of	23andme	of	the	genome	violated	the	federal	law,	and	the	company	has	stopped	offering	them	congenuous	genes	for	good	scientists	say	they	did	not	discuss	the	project	with	the	FDA	.	"We	hoped	this	is	a	bit	different	because	it's	a	research	project,"	said	Abecasis.	When	you	do	research,	you	added,	"you	can	make	a	larger
range	of	things"	that	if	the	sale	of	a	product	or	the	creation	of	a	database	sector.but	proprietary	experts	stress	that	the	FDA	is	also	gaining	in	academic	research.	Several	projects	aimed	at	sequence	of	newborn	genomes,	for	example,	were	held	by	the	FDA.	Green,	which	is	involved	in	many	of	these	projects,	confirmed	that	discussions	with	the	agency
are	underway,	even	if	he	refused	to	reveal	any	detail.	"The	FDA	seems	to	be	constantly	saying,	we	have	this	hammer	and	everything	seems	like	a	nail,"	Misha	Angrist,	Associate	Professor	at	the	Institute	of	Social	Science	Research	at	Duke	University,	said	Buzzfeed	News.	Angrist	hopes	of	genes	for	the	good	project	will	have	successful,	but	suspects
that	will	be	performed	in	regulatory	trouble.	"To	say	enough,	'hey,	we	look	and	we	are	free'	he	is	not	going	to	satisfy	the	paternalists	of	the	world,"	he	said.	With	the	power	of	processing	of	constantly	increased	mobile	devices,	more	and	more	software	companies	are	developing	'tabletised'	versions	of	software	products	undressed	up	to	their	core
functions	to	operate	on	a	very	more	elementary	Platform.While	digital	sculpture	would	seem	a	difficult	task	To	transfer	to	the	mobile	phone,	there	are	a	number	of	excellent	applications	available,	both	for	iOS	and	Android	devices.	In	some	cases,	the	passage	to	tablet	also	clarifies	what	a	particular	product	is	useful	for,	stripped	of	all	the	bells	and
desktop	whistles	of	the	products.in	this	group	test,	I	chose	four	of	the	best	applications	to	sculpt,	and	there	He	put	through	their	steps,	considering	both	the	actability	and	the	real	world	performance.123D	creature	is	the	best	of	testing:	good	performance,	and	a	set	of	rounded	functionality	platform:	iOSDeveloper:	Autodeskprice:	FreeAutodesk	has
two	applications	for	digital	sculpture:	123D	Sculpt	and	123D	Creature.	I'm	reviewing	the	second	here	as	it	comes	with	a	large	built-based	designer.usability	mesh	e	FunctionalityThe	is	easy	to	understand.	The	sculpting	features	are	simple,	but	all	the	essential	elements	Ã	¢	sculpt	in,	sculpt	out,	pinch,	smooth,	grab	and	flatten	Ã	¢	are	covered,	even	if	I
would	have	liked	to	see	a	base	swelling	tool.The	shirt	behaves	very	similar	creator	Zbrush	ZSPheres,	which	allows	you	to	cook	out	a	skeleton	to	sculpt	the:	a	function	that	sets	the	App	head	and	shoulders	over	competition	by	itself.	There	is	easy	set	of	painting	painting	Including	the	possibility	of	painting	through	images,	and	you	can	also	generate
basic	renderings.	You	can	also	export	OBJ	file	via	email.Performancethe	best	of	123D	creature	is	its	performance	seamlessly.	Makes	natural	sculpting	and	organic.conclusionthis	is	that	of	beat.	This	is	a	complete	package,	although	very	reduced	to	the	bone	one,	and	the	creatures	can	be	spit	out	of	them	far	from	those	of	other	applications.	It	is	easy	to
use	and	easy	to	adapt	to	your	normal	workflow.	I	use	it	daily	to	put	out	the	ideas	while	the	commuting	for	work.forger	has	the	largest	series	of	functionality	of	any	application	available,	but	itÃ	¢	s	still	a	lot	of	glitchy	platform:	iOSDeveloper:	Javier	Edoprice:	theory	ã,	£	1.99in	at	least	,	Falsario	is	a	much	more	sophisticated	software	of	123D	creature.	It
is	developed	by	a	Double	negative	artist,	and,	unlike	other	applications,	presents	the	possibility	of	dividing	your	Models.usability	and	FunctionalityForger	looks	like	Maya,	so	you	feel	familiar	immediately.	The	interface	of	her	is	very	smooth,	although	different	functions	require	the	use	of	both	hands,	which	takes	time	to	get	used	to.	It	has	many	more
tools	than	other	applications	Ã	¢	including	an	impressive	clay	brush	similar	to	the	MudBox	wax	tool.	You	can	also	add	additional	objects	and	hide	the	geometry,	it	means	that	you	can	create	scenes.performancethis	much	more	complex	is	where	crumbs	forger.	He	fell	constantly,	and	I	apparently	saving	a	project	just	to	find	my	job	had	gone	when	I
opened	again.	However,	support	is	excellent:	During	the	tests,	I	presented	a	crash	signal	and	the	developer	released	a	correction	works	the	next	day.ConclusionWhen	Falsario,	it	is	a	joy	Ã	¢	is	much	more	in	tune	with	MudBox	and	Zbrush	of	any	Another	thing	on	the	market.	However,	without	the	stability,	it's	just	that	it	is	not	worth	relying	on.	At	the
moment,	the	application	is	simply	more	than	the	iPad	can	Handle.idoughidough	is	a	reasonable	all-round	performer,	but	you	feel	dated	at	the	time	platform:	iOSDeveloper:	CRRateSoftPrice:	Ã,	£	4.99Dough	has	been	one	of	the	first	Sculpt	3D	Apps	for	iOS.	It	has	been	around	some	time,	and	costs	more	than	the	other	three	Combined	Apps.usability	and
FunctionalityThe	tool	set	is	similar	to	other	iOS	applications,	but	there	are	not	many	extras.	You	can	take	the	chance	to	change	the	shader,	even	if	a	good	thing,	since	the	default	value	is	a	horrible	glossy	a	green	and	the	possibility	of	exporting	.Obj	decompressed	files	is	a	nice	change	from	interface	123D	creatures.	The	intuitive	enough,	but	the	brush
settings	can	be	laborious:	at	most	the	radius,	the	brush	is	not	quite	large	enough	for	really	the	shape	of	objects	well,	and	at	the	minimum	radius,	disappears	entirely.performanceperformance	is	good.	There	is	no	real	delay	to	talk	about,	but	this	is	largely	to	do	with	the	fact	that	the	application	has	a	much	lower	limit	than	its	poles
competitors.conclusionidough	has	not	been	updated	since	2010,	And	you	feel	very	similar	to	a	generation	name	sculpting	app.	It	seems	to	be	finalized	more	at	the	general	public	of	3D	artists,	and	what	is	not	easy	enough	to	use,	but	Ã	¢	123D	Creature	and	Forger	are	more	sophisticated	applications,	and	get	to	a	price.TruesculpttruesCulpt	minor	is	the
choice	Better	if	you	use	Ã,	Android	but	thereÃÃ	¢	s	little	competition	platform:	AndroidEdeveloper:	Fabrice	Boyerprice:	FreeTruesCulpt	is	the	most	important	sculpting	application	for	Android.	With	Autodesk	noticeably	absent	from	the	Android	market,	it	is	better	bet.usability	of	non-iPad	users	and	the	functionalityThe	layout	of	the	user	interface	is
similar	to	Idough,	with	icons	on	the	left	side	of	the	screen,	rather	Along	the	lower	part.	All	standard	features	are	present	including	a	mirror	and	basic	tool	tool	tools.However,	the	interface	is	often	an	unituitive	to	sculpt	in	the	shirt,	it	is	necessary	to	force	at	a	negative	value,	for	example	A	and	the	brushes	arrives	in	a	Rotate	menu,	it	means	that	you
need	to	browse	all	of	them	whenever	you	want	to	change	brush:	a	flashy	design	unnecessarily	that	goes	to	the	detriment	of	the	performance.	PERFORMANCEIT	It	is	difficult	to	compare	the	performance	to	the	other	three	applications,	since	for	And	measure,	you're	also	comparing	Android	to	iOS	-	but	unfortunately,	TrueSculpt	doesn't	work	well.
Navigation	is	Cleunky	and	the	delay	when	painting	is	extremely	annoying.ConclusiontruesCulpt	is	the	best	sculpture	app	available	for	Android	-	but	it	is	still	annoying	and	poorly	designed.	I	used	it	for	a	couple	of	days,	then	put	it	back	in	the	box.Words:	Adam	Dewhirstadam	Dewhirst	is	an	elderly	3D	artist	at	the	mill.	He	worked	in	the	sector	for	almost
10	years,	including	Stints	to	Framestore,	Chinese,	MPC,	Passe	Pinelli,	the	BBC	and	the	double	negative.	This	article	is	originally	appeared	in	3D	World	number	187	-	On	sale	now!	Necessary	knowledge:	Basic	Android	app	Developmentrequires:	Eclipse,	Android	SDKProject	Time:	two	hours	to	start	execution	tests,	eight	hours	to	build	an	automatic
night	application	test	Suitesupport	Filethis	item	appeared	for	the	first	time	in	question	219	of.	Net	Magazine	-	The	world's	best-seller	magazine	for	web	designers	and	the	development	of	the	number	of	factors	make	extremely	important	thorough	tests	for	Android	application	developers.	There	are	hundreds	of	different	devices	in	nature,	each	of	the
execution	of	more	potential	versions	of	the	Google	Android	operating	system.	Experienced	developers	who	implement	products	for	the	Android	market	know	that	high	assessments	(and	vice	versa,	an	extremely	smooth,	stable	build)	are	fundamental	to	keep	users	happy	Ã	¢	â,¬	"gaining	a	lot	of	stars	and	generating	downloads.	From	a	perspective	of
the	product,	it	is	essential	to	release	the	stable	bases	from	the	starting	line;	the	test	guarantees	that	the	weaknesses	of	your	application	are	displayed	before	release,	regardless	of	the	different	hardware	configurations.	Wandroid	developers	already	know	that	they	are	developing	for	A	wide	range	of	platforms,	but	can	be	difficult	to	decide	how	to	test
the	best	testing	a	variety	of	devices.	If	you	have	subscribed	to	a	cloud-based	service	that	will	allow	you	to	remotely	test	on	the	actual	hardware?	You	should	outsource	the	tests	on	one	Testing	company?	Do	you	use	emulators	and	hope	for	the	best?	In	Mokasocial,	we	have	a	trial	plane	three	p	Unte	that	exploits	the	tools	available	for	Android	developers
and	gives	us	a	lot	of	confidence	that	we	are	not	releasing	a	buggy	application.	The	process	is	managed	without	requiring	too	much	maintenance	and	requires	relatively	little	set-up.01.	TestSwhere	Unit	Ingemerers	Trust	Industry-Standard	Principles	and	join	the	construction	codes	to	ensure	that	the	final	product	has	failed	in	the	field,	software
developers	trust	in-depth	unit	tests.	More	and	more	more	more,	many	software	development	stores	have	a	certain	degree	of	unified	testing	test.	Implementation	unit	tests	are	an	important	step	to	be	undertaken	to	ensure	that	the	model	classes	are	doing	exactly	what	you	expect.	In	addition	to	this,	the	practice	of	UNITTESTS	writing	in	advance
ensures	that	you	plan	your	objects	while	they	encoded	and	solidify	the	specifications	by	forceing	to	solve	the	ambiguities.	Android	SDK	ships	with	Junit	and	Eclipse	simplify	create	a	project	Junit	test.	The	remaining	challenge	is	for	your	team	to	ensure	that	the	units	tests	are	encoded	for	each	object,	that	the	tests	are	the	most	complete	possible	and
that	effectively	test	the	behavior	of	the	object	under	different	circumstances.	Together,	these	goals	are	indicated	as	the	coverage	of	the	unit	test.	The	tests	of	the	unit	are	good	only	as	their	coverage	-	they	must	be	updated	and	expanded	during	the	development	to	be	effective.02.	Robothium	These	are	two	large	tools	available	for	automated	functional
tests	on	Android.	Everyone	has	its	advantages	and	both	are	easy	to	install	-	we	recommend	having	an	idea	for	what	each	covers.	Robotio	is	a	great	of	user	interface	test	acting	as	a	user;	You	see	what	a	user	sees,	touching	around	the	device	just	like	a	user,	even	go	through	a	landscape	and	portrayed.	Robotium	has	many	of	the	best	unit	test
components	and	regression	tests	-	the	level	of	completeness	depends	on	how	specific	developer	test	scripts	are.	Robotium	is	the	largest	big	Is	that	it	allows	extremely	fine-grained	control	of	viewpoints	and	gives	a	pass	fail	/	result	each.HereÃ	¢	sa	step-by-step	look	at	your	first	turn	of	Robotium	test	scripts	with	Eclipse	Ã	¢	We	are	on	the	assumption
that	you	have	already	the	Eclipse	and	the	Android	SDK	installed	and	configured	on	the	source	of	system.Download	AndroidTesting	project	to	your	computer	and	unzip	to	a	folder	of	your	choice.	Open	Eclipse	and	import	the	AndroidTesting	project	by	selecting	File>	New>	Project>	Android	Project>	Create	project	from	existing	source	and	navigating	to
the	project	that	was	downloaded	source	position.	Download	the	latest	version	of	Robotium	and	selecting	the	new	JAR	file	functionality	robotium-solo	Ã	¢	today,	the	latest	version	is	robotium-only-2.3.jar.	Create	a	new	Android	project	in	Eclipse	called	AndroidRobotiumTest:	File>	New>	Project>	Android	Project.	Fill	in	the	details:	Project	name:
AndroidRobotiumTestBuild	Objective:	Android	Name	1.6Application:	AndroidRobotiumTestPackage	Name:	com.mokasocial.androidrobotiumtestHereÃ	¢	s	our	new	creation	AndroidRobotiumTest	panel	applications	Ã	¢	take	note	of	the	fact	that	we	are	aiming	to	run	the	Android	1.6	our	Eclipse	Appin,	right-click	on	the	AndroidRobotiumTest	project
folder	and	select	build	path>	Configure	build	path,	and	then	on	the	Add	external	JARs	button.	Select	the	Robotium	JAR	file	is	downloaded	in	previous	step	and	click	Open.	While	still	in	the	property	Java	build	path	of	the	project	AndroidRobotiumTest,	click	the	Projects	tab,	and	then	click	the	Add	button.	Check	the	box	next	to	Android	test	project
imported	in	step	two,	entitled	AndroidTesting.	Click	OK	to	close	the	window	of	the	property	and	return	to	the	project.	Open	the	AndroidManifest.xml	AndroidRobotiumTest	the	project	and	add	the	following	code	just	before	the	:	Then	add	the	following	code	just	before	the	tag:	Save	and	close	the	file.	You	have	the	shell	of	an	application	Robotium	ready
to	project	roll.Our	AndroidTest	in	action!	EA	¢	s	nothing	more	than	a	screen	that	shows	/	hides	a	button	that	displays	a	new	activity	04.	Creating	Robotium	testsCreating	a	real	test	Robotium	is	a	piece	of	cake;	WEA	¢	ll	you	walk	you	through	the	basics	of	creating	a	couple	of	test	for	our	simple	example	application,	AndroidTesting.	(All	the	WEA	code	¢
ll	be	creating	already	lives	in	AndroidRobotiumTest	app	in	the	tutorial	files.	Take	a	look	inside	the	/	/	/	/	src	AndroidRobotiumTest.java	com	mokasocial	robotiumtest	file	for	details.)	Output	RobotiumÃ	¢	s	is	in	the	form	of	a	list	of	tests	and	passing	the	resulting	/	fail	for	each	test.	EA	¢	s	very	good	at	controlling	the	quantitative	details	of	user	interfaces
you	can	check,	for	example,	that	after	tapping	the	Tap	This!	button	in	our	application,	a	hidden	button	is	shown.To	begin,	create	the	basic	shell	of	your	test	class.	Right-click	on	your	app	AndroidRobotiumTest	com.mokasocial.robotiumtest	package	and	select	New>	Class	A	call	AndroidRobotiumTest.java	class.	The	class	needs	to	extend
ActivityInstrumentationTestCase2	,	where	activityName	is	the	name	of	the	activity	that	we	are	to	testing.	In	our	case,	the	task	name	is	MainActivity,	in	order	to	create	the	class	like	this:	public	class	extends	AndroidRobotiumTest	ActivityInstrumentationTestCase2	{//	Our	tests	are	soon	to	come	...}	All	tests	have	three	Robotium	basic	functions	a
manufacturer,	setup	()	and	teardown	()	that	tell	the	application	to	which	the	activity	we	are	starting,	initial	variables	WEA	D	how	to	set	up,	and	any	restore	database	and	/	or	activity	WEA	D	as	at	the	end	after	each	test.inside	Our	new	class,	WEA	LL	need	for	functions	as	follows:	AndroidRobotiumTestest	public	()	{super
("com.mokasocial.androidtesting",	mainactivity.class);}	//	Our	setup	...	Public	Void	Setup	()	Throws	Exception	{	Soloist	=	New	New	Getivity	());}	//	Our	Therodown	...	Public	Void	Teardown	()	trap	exception	{try	{only.finalize	();	}	Capture	(Buttable	e)	{e.printstackTrace	();	Getivity	().	Finishing	();	Super.Tearwown	();}	Now	that	we	have	our	necessary
robotium	functions	included	in	our	class,	we	can	write	a	function	that	actually	performs	an	area	of	​​our	AndroidTest	app.	Verify	that	our	hidden	button	is	shown	when	a	user	touches	the	faucet!	button.	Start	creating	a	function	in	your	AndroidRobotiumTest	class	called	TestClickFirstButton	()	and	you	have	a	robotium	click	our	tap	this!	Button:	Public
Void	TestClickFirststButton	()	Throw	exception	{//	Click	on	our	button!	Solo.ClickonButton	("touch	this!");}	Add	planned	and	effective	variables	and	finish	with	a	call	Assertequals	()	to	make	sure	that	our	expected	and	effective	VARs	correspondence:	Public	Void	TestClickFirstButton	()	trap	exception	{//	Click	On	the	button!	Solo.ClickonButton	("Touch
this!");	Boolean	expected	=	true;	actual	boolean	=	solno.searchbutton	("Hidden	button!"	True);	//	stating	that	our	hidden	button	is	no	longer	hidden	assertequals	("our	hidden	button	is	still	hidden!",	Expected,	current);}	If	the	values	​​do	not	match,	then	we	will	be	launched	the	error	Ã	¢	â,¬	Å	"Our	hidden	button	is	still	hidden!	Â	»And	the	robotium	will
conclude	the	test	as	failed.	Sa	Snippet	of	the	MainActivity	file.java	from	our	AndroidTest	project.	The	finished	product	is	easily	worth	the	effort	to	write	code	05.	Running	your	Testrunning	robot	the	test	could	not	be	easier;	Right-click	on	the	AndroidRobotiumTest	project,	select	Run	as,	then	Android	Junit	Test.	The	Android	emulator	will	load	your	app
and	start	touching	the	tests.	The	test	results,	including	working	tests,	errors	and	faults,	will	be	displayed	in	the	Junit	tab	in	Eclipse.Read	on	everything	that	the	robotio	has	to	offer	by	visiting	the	Tutorial	section	of	its	website.	All	the	example	test	code	of	Mokasocial	can	be	cloned	in	our	repository	github.	Watch	our	completed	robotium	test.	Each	test
function	has	a	complete	completion	time	(shown	in	seconds)	and	can	be	double	clicked	to	focus	on	the	relevant	code	06.	The	Monkeyrunner	instrument	of	MonkeyRunnerDroidRand	"is	included	in	the	Android	SDK	and	meets	a	function	similar	to	robotio,	but	With	a	different	approach.	Monkeyrunner	uses	Jython	(a	Python	implementation	in	Java)	script
to	cross	the	applications.	It	is	particularly	good	at	walking	through	multiple	devices	or	emulators.	However,	rather	than	the	pass	/	fail	testing,	take	screenshots	on	designated	points.	The	narrow	integration	of	the	robotium	user	interface	is	missing,	but	it	is	much	easier	to	get	up	and	running.	It	is	also	skilled	in	the	management	of	multiple	emulators
and	devices.	The	DonyKeyRunner	approach	is	to	cross	the	application,	clicking	On	the	buttons	and	taking	screenshots	throughout.	After	the	script	is	performed,	you	can	compare	the	screenshots	made	with	those	that	you	as	Petting	to	see.	If	you	hit	a	button	that	didn't	work,	or	wraps	in	the	wrong	activity,	you	will	know	rights	directly.	It	is	a	very
configurable	stress	test	engine	running	absolutely	brutal	tests	on	devices	by	quickly	sending	pseudo-random	input	commands.	Monkeyrutunner	taps	and	drag	on	the	screen,	change	the	orientation	of	the	device	and	crush	the	keys.	It	is	particularly	effective	to	find	things	that	also	dedicated	test	scripts	have	not	won,	because	it	works	fastest	than	a	user
and	will	happily	pound	on	a	button	five	times	before	loads.	Want	to	have	access	to	all	of	your	app's	activities,	so	if	you	have	a	screen	that	is	particularly	difficult	to	You	may	want	to	write	a	workaround	to	get	to	it.	We	also	want	the	Cordon	Monkeyrutunner	to	a	trial	version	of	any	live	API	and	use	the	-P	option	to	limit	it	to	the	designated	package.07.
Putting	it	all	the	tests	together	to	configure	and	write	some	time	to	configure	and	write,	but	once	you	do	them	go	and	give	a	lot	of	confidence	to	the	development	process.	In	Mokasocial,	our	system	consists	of	a	dedicated	testing	machine	that	was	set	to	run	running	Unity	test,	functional	tests	and	monkeyrutternner,	before	repeating.	Every	morning,
an	e-mail	is	sent	to	the	development	team	with	a	test	report.	It	is	worth	our	initial	set-up	effort.	When	we	start	a	new	project,	functional	tests	and	unity	tests	must	be	rewritten,	but	the	test	script	cloning	is	as	simple	as	copying	and	paste.	If	you	want	to	run	regular	automated	tests,	here	are	some	steps	to	start:	Safe	a	test	server	Ã	¢	â,¬	"You	probably
want	a	dedicated	test	box,	it's	not	turned	on	by	another	daily	use.	The	operating	system	does	not	It's	important,	but	you	would	like	to	be	at	ease	by	putting	together	and	plan	the	shell	scripts	on	it.	Get	some	test	devices	-	This	step	is	optional,	as	you	could	choose	instead	of	creating	a	series	of	separate	hardware	configurations	with	separate	hardware
configurations	With	separate	hardware	configurations	with	separate	hardware	configurations	with	separate	hardware	configurations	.with	crontab	or	scheduler	activity,	schedule	a	script	(an	example	is	included	in	the	tutorial	files)	to	do	the	following:	Start	a	logfile	with	tee	and	start	writing	all	the	outputs	(	Feel	free	to	replace	the	preferred
registration	method!)	Pull	the	project	The	last	source	font	your	test	units	Texts	with:	AD	B	shell	am	tool	-w	your.package.name.tests	/	android.test.instrumentation	testrunnerrun	your	monkeyrunner	script:	monkeyrunner	monkey_runnerrest.jyrun	your	monkey	test	with	a	command	as:	adb	shell	-	monkey	-p	your.package.name	-v	5000000mail	The
results	to	yourself	or	your	team.	Now	you	can	read	the	test	completions	with	morning	coffee.	Good	boy!	Words:	John	Senner	and	Koa	Metter	Metter	and	Emory	Myers,	Agency	based	on	Seattle	Mokasocial	www.mokasocial.com	brings	a	tasty	application	design	and	high	quality	development	on	your	phone.	Phone.
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